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THE DAVIDSON COMPANY CHARTER

At Davidson, we are committed to excellence in education. We strive
for excellence in the products we create; we strive for excellence in
the service we provide to our customers; we strive for excellence in
the way in which we conduct our business. We believe that education
enhances the quality of life and that our contribution to the enhance-
ment of education will enrich the customers we serve.

Our Guiding Principles:
*  Quality is our first priority.
Customers are the focus of all our efforts.
Seeking a better way is essential to our success.
+  Employee involvement is our way of life.
Dealers and suppliers are our partners.
Integrity cannot be compromised.

TECHNICAL SUPPORT
Support outside the US. and Canada is available via fax, mail, and on-line services only.
Phone: (800) 556-6141 or (310) 793-0600, 7AM-6pM Pacific Time, Mon-Fri
Fax: (310) 214-7937, 24 hours daily « World Wide Web: http//www.davd.com
Direct E-mail: support@davd.com * America Online: keyword, Davidson
Muail: Technical Support, Davidson & Associates, Inc, P.O. Box 2961, Torrance, CA 90509

© 1996 Davidson & Associates, Inc. © 1996 Fisher-Price, Inc. Fisher-Price® trademark is used under license from
Fisher-Price, Inc Manufactured and distributed by Davidson & Associates, Inc, Torrance, California 90503,
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System Requirements for Windows® 95 or 3.1x

486/33 MHz or faster DOS-compatible computer with 8 MB of RAM
Hard disk with 1 MB free disk space (35 MB for full installation)
Sound Blaster® or almost any Windows Multimedia sound card
Windows 3.1 or Windows 95 v Mouse

Double-speed CD-ROM drive v SVGA card (256 colors)

Installing and Running with Windows® 95

Insert the Great Adventures by Fisher-Price™ Castle CD into your drive.
Setup will start automatically.

Select CD Only for the minimum install, or select Full Install to install
the whole program to your hard disk for maximum performance.
After the CD Only install, insert the Great Adventures by Fisher-Price™
Castle CD into your drive. The program will start automatically.

After the Full Install, select Start from the Windows 95 Taskbar, then
search through Programs\Fisher-Price Castle and select the Castle icon.

Installing and Running with Windows® 3.1x

Insert the Great Adventures by Fisher-Price™ Castle CD into your drive.
Select Run... from the File menu in Windows Program Manager.

Type d:\setup and press ENTER. (D is the location of your CD-ROM drive.
If your CD-ROM drive is not D, type the appropriate letter)

Select CD Only for the minimum install, or select Full Install to install
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the whole program to your hard disk for maximum performance.

* A new icon and program group named Fisher-Price Castle will be
created.

«  After the CD Only install, insert the Great Adventures by Fisher-Price™
Castle CD into your drive (not needed for Full Install).

«  From Program Manager, find and open the Fisher-Price Castle program
group and double-click the Castle icon to run the program.

Installing and Running on a Macintosh®

v Motorola 68040 or Power PC™ (eg, Performa™ 575, Quadra™, or better)
v 256-color graphics with 14" monitor v 12 MB of RAM (8 MB free)
v Double-speed CD-ROM drive v System 7.1 or higher

To run the program from the CD, insert it into your CD-ROM drive and
double-click the Run from CD-ROM icon.

Hard disk installation requires at least 38 MB of free hard disk space.
To install to the hard disk:

« Insert the Great Adventures by Fisher-Price™ Castle CD into your drive.
Double-click the Install to Hard Drive icon.

Click Continue, then click Continue again.

Click Install. At the “Installation was successful” screen, select OK.
To start the program, double-click the Fisher-Price Castle folder, then
the Fisher-Price Castle icon.

WELCOME TO GREAT ADVENTURES
BY FiSHER-PRICE” CASTLE

Bad King Smudge and his Naughty Knights have
captured King McBeard and his Castle, sending his
Good Knights to hide in the village.
King Smudge

You must help McDuff find all six of the Good
Knights, storm the Castle,

T McDuff

and rescue King McBeard from
the Dungeon.

King McBeard

Naughty Knight



Playing a Game

FisherPrice’

At the Fisher-Price® button screen,
you will see these options:

T Find All the Good Knights
@ Click this button to play the entire game.

Find Two Good Knights
Click this button for a shorter game.

= Exit
Click this button to exit

the program.

Credits
Click this button to see
the production team.

Note: To bypass the Introduction or the dialog in any scene, press the

SPACEBAR.
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Getting Around

Fach scene has two buttons on-screen at all times:

Exit Jester's Hat
EXH- Click this button to g Click this button to

quit the program. get help from Jester.

Note: Each activity can be replayed after the Good Knight has been
found.

Help

If you need help, click Jester's Hat and he'll appear. Ask
him again and he'll give you more clues.



Village Square McFadden’s Hotel

This is the Main Screen. From here, you can travel with McDuff any-
where in the kingdom to find the Good Knights and recruit them for the
mission to rescue the king.

Sir Mount, the climber knight, is hidden here. To find him:
+ Click around to find the missing stones. e
+  Click a matching stone to have McDulff get it.

+ Click the right spot above the fireplace -..

to place the stone.

Note: The cursor turns into a magnifying glass Q when you move it

Note: The cursor will tiih into thicamow ﬁ to let you know that if you over a place where a stone is hidden. The cursor then turns into a hand

click here, McDuff will go to a new location in the kingdom. when you move it over a stone. McDuff only picks up a stone that

fits into a spot above the fireplace.
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Marketplace Magic Cave

-———

El-Asto, the elastic-morphing knight, is hidden

here. To find him, you must trade the item

McWiz, the magic knight, is hidden here.
Click the crystals in the same order Eli zaps them.

Jester gives McDulff at the tents until you can I
McWiz

trade for the Good Knight.

A
El-Asto

Note: The cursor will turn into a lightning bolt % when moved

over the crystals. Use the lightning-bolt cursor to zap the crystals.
Note: The cursor will turn into a hand ‘ when it moves over

a clickable area.



Stream

Sir Cyclone, the spinning knight, is hidden
here. Click around the screen to find him.

Sir Cyclone

Note: The cursor will turn into a magnifying glass Q when
moved over a clickable area.
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Tournament

Sir Shield-In-Hand is the knight operating the
cannon. His hands transform into large shields for
protection. He is chained to the cannon and can be
freed only after you have destroyed
Sir Shield- the target. Hit the target twice and
In-Hand  McDuff will free Sir Shield-In-Hand.

Note: The cursor will turn into a hand ‘ when moved over a
clickable area.

11



Blacksmith’s Castle

The knight Sir Lift-A-Lot is posing as a
Sir Lift-A-Lot  blacksmith here. He is the strongest of the
Good Knights. You must help McDuff
find all the other knights before he'll help.

Click the Good Knights in the correct order to attack the Castle and

| drive all the Naughty Knights out. If you have selected Find All the
Good Knights at the beginning, you can only storm the Castle after
you have found all six knights.

Note: The cursor will turn into a hand ‘ when moved over a

Note: The cursor will turn into a hand . when moved over a
clickable area.

clickable area.
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Dungeon

Click the correct knights to get rid of King Smudge
and unlock the dungeon door to free King McBeard.

Note: The cursor will
turn into a hand .
when moved over a
clickable area.
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THE GREAT ADVENTURES BY
FisHER-PRICE" CASTLE TEAM

Producer: André PR. Zietsman; Associate Producer: Brian Poole

Executive Producer: Mike Albanese

Programmers: Dan Phillips (Lead), Albert Cheng

Lead Animator: Ben Badgett; Graphic Designer/Animator: Jeff Schaid

Senior Illustrator: Brian Kemper

Storyboarding/Screen Design: Ben Badgett, Brian Kemper

Script: André Zietsman, Mike Albanese, Tony Marino

Music Composition: Scott Lynch

Sound Design: Christian Johnson; Sound Editor: Scott Lynch

Recording Engineer: Robert Koenigsberg

Manual: Kelly Yeary

Voice-over Talent: Shawn Crosby, Zach Love, Wayne
Yorke, Richard Osborne, Lucy Hagen

Quality Assurance: Roger Hu, Pam Wissinger, Johnnie
Tam, Barbara Woodcock, Cesar Huaman, Sonia Ajang

Macintosh version developed by Callisto Corporation.
Senior Producer: Faye Schwartz; Quality Assurance Lead: Dionne McCray

Special thanks to Fisher-Price®, John Sosoka, Leslie House, Bob Dietz, Thomas
Su, Tyler Wilson, Betsy Morris, Steve Huot, Gina Schmitz, Joe Skelley, and
Jean Zhou.
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Before You Call Technical Support...

Please gather the following information:

Windows 95 and Windows 3.1x

. Product name and version number (on the CD) of the product.
The processor and clock speed (e.g, 486/66) of your computer.
3. Your operating system’s version number. At the DOS prompt (c:\), type ver and
press ENTER. The number will appear.
The brand name of the sound device installed in the computer.
The amount of free memory (available to run the program) you have, In
Windows 3.1x, go to the Program Manager and select About Program
Manager from the Help menu; in Windows 95, open Explorer on the
desktop and select About Windows 95 from the Help menu. From the
dialog box that appears, write down the Memory and System Resources values.
If a Details button appears, click it and write down the information.
6. The complete and exact error message reported by the program (if any).
7. A printout of your config.sys and autoexec.bat files.
Macintosh
1. Product name and version number of the product (on CD label).
2. Your Mac’s model name and system version #. (See About This Macintosh on

the Apple menu)

N

Y1

Support outside U.S. and Canada via fax, mail, and on-line services only.
Phone: (800) 556-6141 or (310) 793-0600, 7AM—6PM PST, Mon-Fri
Fax: (310) 214-7937 + World Wide Web: http//www.davd.com
Direct E-mail: support@davd.com * America Online: keyword, Davidson
Mail: Support, Davidson & Associates, Inc, P.O. Box 2961, Torrance, CA 90509
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LIMITED WARRANTY
Davidson & Associates, Inc. warrants fora period of ninety (90) days from the date of purchase that the software
title contained in this package shall be free from defects in material and workmanship. In the event that this
software title proves defective during that time period, Davidson & Associates, Inc. will at its option 1) correct
any defect; 2) provide the customer with a functionally equivalent disk; or 3) provide a refund of the purchase
price upon receipt by Davidson & Associates, Inc. of proof of purchase and the defective product.

REPAIR, REPLACEMENT, OR REFUND AS PROVIDED IN THIS WARRANTY IS THE EXCLUSIVE
REMEDY OF THE CONSUMER. DAVIDSON SHALL NOT BE LIABLE FOR ANY INCIDENTAL OR
CONSEQUENTIAL DAMAGES FOR BREACH OF ANY EXPRESS OR IMPLIED W ARRANTY. EXCEPT TO
THE EXTENT PROHIBITED BY APPLICABLE LAW, ANY IMPLIED WARRANTY OF MERCHANTABILITY
OR FITNESS FOR A PARTICULAR PURPOSE ON THIS PRODUCT IS LIMITED IN DURATION TO THE
DURATION OF THIS WARRANTY.

Some states do not allow the exclusion or limitation of incidental or consequential damages, or allow limi-
tations on how long an implied warranty lasts, so the above limitations or exclusion may not apply to you.

COPYRIGHT NOTICE
The software and the manual are copyrighted. All rights are reserved. They may not,in whole or part, be copied,
photocopied, reproduced, translated, or reduced to any electronic medium or machine-readable form without
prior consent, in wriling, from Davidson & Associates, Inc. The user of this product shall be entitled to use the
product for his or her own use, but shall not be entitled to sell or transfer reproductions of the software or
manual to other parties in any way, nor to rent or lease the product to others without written permission of
Davidson & Associates, Inc.

Macintosh® is a registered trademark and Performa™ and Quadra™ are trademarks of Apple Computer, Inc.
Windows® is a registered trademark of Microsoft Corporation. Sound Blaster™ is a registered trademark of
Creative Labs, Inc. IBM® is a registered trademark and Power PC™ is a trademark of International Business
Machines, Inc.
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WIN

$25

J‘o ) pgs,

Register this product
electronically or by mail and
be entered in a drawing to
win software!

Davidson.

Dffer good i the United States caly. Ome winnes will be chesen och meath. Entry
or eoxch drowing is bmited to cae eniry for eoth product regisiration form per
mosth. Or yow may ender once per monih by prinfing yeur full name, oddress,
ond telephsne member on o 3°x5” cord ond mading it fe: Davidson & Associstes
Sweegsiokes, 19840 Fomeer Ave., Tormonce, (A 90503. No purchese necessary
to win. Employees ond fomilies of Davidson & Associaes or eny of its divsions
ot ok liible. Winners wil be moifed by moi within 30 doys of selectin. Al
fedaral, state and lcal lows spphy. Odds of wianing depand on the number of
ealries received. Yoid wh.rwﬁw OFfer expires December 31, 1998,
Fishes-Price trademarks ere used under fceasa from Ficher-Price, Inc,
36 Giraed Avenue, Eost Awrore, New York 14052
(@ 1995 Darvidsan & Associotes, Inc. Al rights reserved.

gitered trodemark of Micrsaft Corporntion

Macibssh is @ registered rodemark of Apple Compater, Inc.

~ (800) 556-6141

USER’S MANUAL INSIDE
h(-11]:3 SJ\;I;FACTIOH_
IS GUARANTEED

At Davidson, we constantly
strive to create the best
multimedia educational
‘software available. But our
commitment to excellence
| doesn’t stop there. We are one
of the only educational
software publishers to
provide TOLL-FREE TECHNICAL
SUPPORT. Plus, we offer you a
30-DAY 100% SATISFACTION
GUARANTEE—if for any reason
you are not completely
satisfied with this product,
return it to us at the address
on this booklet within 30 days
of purchase with receipt. We
will gladly exchange it for a
product of equal or lesser
value or refund your money.

Declers, distributors and thei employess me not gble.

Sales/Customer Service:

(800) 545-7677

TOLL-FREE
Technical Support:

or call
(310) 793-0600

Inte
http:/ /www.education.com

Look for these exciting new Fisher-Price titles from Davidson!
Fisher-Price Ready for Preschool™
Fisher-Price A-B-C’s Featuring the Jungle Jukebox™
Fisher-Price 1-2-3's™ i ]
Price Sing-Alongs: Barnyard Rhy:hm“&'Mc-ns"
-Price Learning in.Tr_ly-I.and i ]
d\‘f‘bntures by Fi: ] Age: 3—7
| P;_gl:s. 45

Fisher-Price Ready for School™-Kindergarten Edition
| Ages 4-7

Fisher-Price Read and Play Library™
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